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BEFORE
YOU BEGIN

Thank you for buying LanSafe III Version 3.6 power
management software for your network. With the new
LanSafe III installed and running with your UPSs, you
have state-of-the-art tools for fault tolerance. LanSafe III
gives you the ultimate in control over your power
protection system.

WHAT’S NEW?
If you already know LanSafe software, you know how
well it extends the usefulness of your UPS. Version 3.6
brings the following new features to the environments of
Novell Netware, IBM OS/2, and Microsoft Windows 3.1x,
Windows 95 and Windows NT:

◆ Modem/pager capability, enabling you to program
your software to send alert condition notices to
anyone, anywhere, on-site or off

◆ Customizable alert responses and commands,
allowing you to program your computer to make an
individual response for each kind of alert message
instead of one response for all messages

◆ Support for other manufacturers’ UPSs

◆ Ability to export log information to a text file you
can print, edit, or save

◆ Power up and power down sequencing of load
segments (when supported by UPS)

◆ Weekly scheduling of UPS on and off times (when
supported by UPS)

◆ Support for DEC Alpha environment (Windows NT)
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A POWERFUL COMBINATION
When you choose LanSafe III and your UPS to protect
your sensitive computer equipment, you get the best.
LanSafe III brings you timely status messages and reports
whenever required, and informative power status data
displays, too. If a shutdown is necessary, it is orderly and
sequential. LanSafe III supports individual computer-UPS
installations and UPSs supporting groups of computers.
You can control all nodes in your network from one
remote location, making configuration changes without
restarting your network.

YOU GET TIMELY STATUS MESSAGES AND REPORTS
LanSafe III’s Power Monitor notifies you of any signifi-
cant change in your power situation.

The LanSafe III Console is always there for you to refer to
any time you want to check the status of battery power,
operations, and communications. Knowing how much
battery time you can count on is vital after a power
failure when the power returns but you can’t be sure for
how long. You can balance your loads as LanSafe III
shows you how adding or subtracting equipment affects
available battery time. You can readjust the shutdown
timing of a node or a network.

YOU HAVE A CHOICE OF DATA DISPLAYS
For fast pictures of power status, LanSafe III graphical
user interfaces are as good as they get. PowerScope
provides a picture of the inner workings of the UPS so
you can tell at a glance what’s happening to your power.
Data view puts the information in front of you in color-
coded bar-graph form.

The Power Log and Battery Management Log show you
exactly when a change in power occurred. You can
correlate reports from the same moment.

Section 1  ◆  Before You Begin
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YOU GET ORDERLY AND SEQUENTIAL SHUTDOWNS
With minimum network traffic, LanSafe III operates with
your UPSs to maintain constant watch over your power
situation. If a disturbance occurs, the UPS shifts to inverter
power or otherwise reacts as it was designed to do.

Meanwhile, LanSafe III waits for an interval (wink time)
to be sure the problem isn’t momentary, then informs
users so they can save their work (power failure count-
down time). Finally, if the UPS remains on inverter, the
orderly shutdown sequence automatically begins (unless
your system is DOS-only when it requires a manual start).
The shutdown sequence should be complete before the
end of the user-programmed time needed to down
system.

YOU GET INDIVIDUAL AND UPS GROUP SUPPORT
LanSafe III adapts to your network. LanSafe III supports
single-node UPSs. It supports UPSs supporting as many
as 64 network devices. LanSafe III is available for Novell
Netware, Windows 3.1x, Windows 95, Windows NT,
UNIX, OS/2, and Macintosh platforms. LanSafe III
supports every computer function — server, domain
controller, workstation — to the same degree.

YOU GET REMOTE ACCESS AND CONTROL
LanSafe III’s access code system benefits you as a net-
work administrator. From a single location, you can, if
you have the proper access code, remotely control all
UPSs on your network to:

◆ Change the operating settings for any network UPS
with the same protocol without reinstalling the
software or rebooting the computer

◆ Verify the installation and phase wiring for all
workstations with multiple-phase UPSs

◆ Initiate one-button hardware testing for a specific
node, combination of nodes, or the network

◆ Reboot or shut down any network node

◆ Unload LanSafe III on any node
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UNDERSTANDING UPS GROUPS
There are differences, albeit small ones, in the installation
and operation of LanSafe III when your UPS supports one
computer and when it supports two or more computers.
If the computers in your system each have their own
UPSs, you need not be concerned with this section.

UPS GROUP TERMINOLOGY
When one UPS supports more than one computer, the
supported computers are called a UPS group.

Only one computer in a UPS group can be attached to the
UPS by means of a serial communications cable. This
computer is known as the UPS group controller. Any
computer in the UPS group that is not the UPS group
controller is known as a UPS group member.

Figure 1-1 shows the interaction between the computers
in a UPS group.

Network Cabling

Communications

UPS

AC Power

Group Member

Group
Controller

Group MemberGroup Member

Figure 1-1. UPS Group Configuration

Section 1  ◆  Before You Begin
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UPS GROUP COMMUNICATIONS REQUIREMENT
LanSafe III communications require that the UPS group
controller be running whenever any group member is
running. Otherwise, the LanSafe III UPS monitoring
module, which runs on each group member, cannot
obtain UPS status and alert information from the group
controller. This means that UPS group members are not
notified of power failures and do not perform an orderly
shutdown.

TO GET THE MOST FROM THIS
MANUAL

1. Become familiar with the features of LanSafe III by
reading Section 1, Before You Begin.

2. Follow the steps outlined in Section 2, Installation, to
install the UPSs and LanSafe III on your network.

3. After installation, use the LanSafe III Console func-
tions described in Section 3, Operation, to familiarize
yourself with the program.

This LanSafe III Installation and Operation Manual is
intended for those with experience in hardware and
software in Novell, DEC Alpha, Microsoft or IBM net-
work environments. It is assumed you understand the
basic procedures for working with such systems.
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Section 1  ◆  Before You Begin
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INSTALLATION

To install your LanSafe III software, be sure your system
meets the appropriate requirements. Then follow the
general installation procedure.

N O T E
Windows 95 Plug and Play driver users:  Af-
ter you install LanSafe III and restart your com-
puter, the UPS Status icon on the taskbar be-
comes the Power Monitor icon. To reconfigure
your UPS from your desk, access the UPS Sta-
tus applet from your Windows 95 Control
Panel.

SYSTEM REQUIREMENTS
This section includes the system requirements for install-
ing LanSafe III in the following environments:

◆ OS/2 (LAN server and clients)

◆ Windows 95 (NetWare or Windows NT clients)

◆ Windows 3.1x and DOS (NetWare clients)

◆ Windows NT (server and workstation)

◆ Novell NetWare (file server)

◆ Novell ManageWise (file server)

◆ NMS Management Console Workstation

S
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OS/2 (LAN SERVER AND REQUESTERS)
For you to install and operate LanSafe III for OS/2, your
system must include the following:

◆ IBM OS/2, version 2.0, 2.1, 3.0 (WARP) or higher

◆ An RS-232 serial port for the UPS

◆ A dedicated RS-232 serial port, if the modem feature
is used

◆ One mouse (optional)

◆ The correct cable for communications between your
UPS and your computer. Consult your UPS vendor
for help in choosing the right cable.

WINDOWS 95 (NETWARE OR WINDOWS NT CLIENTS)
For you to install and operate LanSafe III for Windows 95,
your system must include the following:

◆ Microsoft Windows 95 (Windows 4.0 or higher)

◆ NetBEUI or IPX/SPX protocol loaded [LanSafe III
requires NetBEUI in LAN Server (OS/2) and Win-
dows NT environments, and IPX/SPX (IPXODI) in
NetWare environments]

◆ An RS-232 serial port for the UPS

◆ A dedicated RS-232 serial port, if the modem feature
is used

◆ One mouse (optional)

◆ The correct cable for communications between your
UPS and your computer. Consult your UPS vendor
for help in choosing the right cable.

Section 2  ◆  Installation
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WINDOWS 3.1X OR DOS (NETWARE CLIENTS)
For you to install and operate LanSafe III for Windows
3.1x or DOS, your client systems must include the
following:

◆ Any IBM PC/AT/386/486

◆ IPXODI.COM must be running

◆ An RS-232 serial port for the UPS

◆ A dedicated RS-232 serial port, if the modem feature
is used

◆ One mouse (optional)

◆ The correct cable for communications between your
UPS and your computer. Consult your UPS vendor
for help in choosing the right cable.

WINDOWS NT (SERVERS AND WORKSTATIONS)
For you to install and operate LanSafe III for
Windows NT, your system must include the following:

◆ Windows NT, version 3.1, 3.5x, or 4.0

◆ Network services installed

◆ An RS-232 serial port for the UPS

◆ Operator must have administrator privileges

◆ A dedicated RS-232 serial port, if the modem feature
is used

◆ One mouse (optional)

◆ The correct cable for communications between your
UPS and your computer. Consult your UPS vendor
for help in choosing the right cable.

In addition, since LanSafe III for Windows NT is a system
service, you must log on as an Administrator to install it.
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NOVELL NETWARE (FILE SERVERS)
For you to install and operate LanSafe III for Windows
3.1x, your system must include the following:

◆ NetWare 386 version 3.10 or higher

◆ Write access to sys:\system directory

◆ An RS-232 serial port for the UPS

◆ Log on to file server where LanSafe is being installed

◆ A dedicated RS-232 serial port, if the modem feature
is used

◆ One mouse (optional)

◆ The correct cable for communications between your
UPS and your computer. Consult your UPS vendor
for help in choosing the right cable.

Install LanSafe III on a server from any Novell NetWare
workstation under DOS, Windows, or Windows 95 with
network access to the file server where it will be installed.

Log on to the file server being installed. Write access to
sys:\system directory is required.

NOVELL MANAGEWISE (FILE SERVERS)
◆ Novell NetWare 3.11+ or 4.0+ installed

◆ Novell NetWare SNMP.NLM version 2.0 or above

◆ 200KB of free disk space for LanSafe III ManageWise
files

◆ 200KB of memory for LanSafe III for ManageWise

◆ Operators must have Supervisor rights

Section 2  ◆  Installation
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MANAGEWISE (NMS MANAGEMENT CONSOLE
WORKSTATIONS)

◆ MS-DOS 5.0 through 7.0, or Novell DR DOS 6.0 or 7.0

◆ Windows version 3.1 or 3.11 or Windows 95

◆ Novell NetWare ODI device drivers or NetWare 4.0
requester

◆ 45KB free disk space for LanSafe III files

◆ 250KB of memory

◆ VGA or Super VGA super graphics adapter and
monitor

◆ One of the following: Novell NMS v. 1.15 (min. 8 MB
RAM), v. 2.0 and above (min. 12 MB RAM), or
ManageWise v. 1.0 through v. 2.1 (min. 16 MB RAM).

◆ Supervisor rights

INFORMATION REQUIREMENTS
Before you install LanSafe III, you will find it useful to
have the following information:

FULL INSTALLATION IN STANDALONE SYSTEMS AND
UPS GROUP CONTROLLERS

◆ The make and model of your UPS

◆ The number of the communications port to which the
serial cable to the UPS is connected

◆ Your access code

◆ A machine name for your computer

◆ A location for your LanSafe III files if you do not
choose to accept the default location which is C:\LS3
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FULL INSTALLATION IN UPS GROUP MEMBERS
◆ If installing OS/2 or Windows NT, the domain name

and computer name of your UPS group controller. If
installing DOS, the group controller server name and
network address.

◆ A location for your LanSafe III files if you do not
choose to accept the default location which is C:\LS3

REMOTE SERVICES INSTALLATION
A location for your LanSafe III files if you do not choose
to accept the default location which is C:\LS3

USING LANSAFE III WITH
OTHER-VENDOR UPSS
This applies to any UPS not listed in the UPS Model
section of the Setup dialog box in the Setup or Install
program. If your UPS is not listed, you have an other-
vendor UPS. Contact the other UPS manufacturer and
purchase a Windows NT cable with instructions. The
Windows NT cable is used with LanSafe III, regardless of
platform.

Install LanSafe III using this cable. When the Setup dialog
box opens, select Generic Dry-Contact UPS as your UPS
model. The UPS Model Configuration dialog box opens.

When prompted to configure your system [with radio
buttons for AC Fail Signal, Low Battery Signal, and UPS
Shutdown Signal] refer to the instructions accompanying
your Windows NT cable.

Test the function as described in this manual.

N O T E
If you do not set the radio button settings prop-
erly the first time, you must reinstall LanSafe III.

Section 2  ◆  Installation
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GENERAL INSTALLATION PROCEDURES
1. Insert the LanSafe III installation medium (floppy

disk or compact disk) into your computer’s disk
drive. If you install from floppies, be sure you insert
the disk marked for your program.

2. Using the list below, change to the correct directory
for your system.

Type of computer to install Use CD install program
DOS Workstation NOVWIN\INSTALL.EXE

NetWare Server NOVWIN\SETUP.EXE

Windows 3.x Workstation NOVWIN\SETUP.EXE

Windows 95, NetWare Network NOVWIN\SETUP.EXE
Workstation

Windows 95, NT NetworkWorkstation NTWIN\SETUP.EXE

Windows NT Workstation/Server NTWIN\SETUP.EXE

Windows NT DEC Alpha Workstation/Server NTALPHA\SETUP.EXE

OS/2 Requester/Server OS2\INSTALL.EXE

3. Run the install program for your system as indicated
on the list.

The Welcome to LanSafe III screen opens.
Novell NetWare users:  If a message opens saying you
must log on to a server with Supervisor rights, it is
because you are not logged on to a file server or because
the account you used lacks Supervisor rights. Log on
again, using an account with Supervisor rights.

4. Choose Cancel to exit the installation program or
Install to proceed.
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POST INSTALLATION PROCEDURES
1. Start the Power Monitor.

To start the Power Monitor, do one of the following:

◆ All users except DOS:  Double-click the Power
Monitor icon

◆ Windows 95 users: Run LS395
Windows 3.1x users: Run LS3.EXE
All other users: Run LS3.EXE

◆ All users:  If you accepted the Automatic Load
option, restart your computer

2. Start the Console to familiarize yourself with its
controls.
Do one of the following:

◆ Choose Run Console from the Power Monitor
window

◆ Double-click the Console icon

◆ Windows users:  Run LS3CONW.EXE
Windows 95 users:  Run LS3CON.95
All other users:  Run LS3CON.EXE

See Section 3, Operation, for a description of
Console controls.

DOS users:  The Console is not supported.

3. Run a hardware test.
Choose Test Hardware from the Console Mainte-
nance menu. When the Test Hardware dialog box
opens, choose Start. The test takes about 40 seconds.

Section 2  ◆  Installation
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POST INSTALLATION PROCEDURES
(LANSAFE III FOR MANAGEWISE)

Prerequisites:
a) Successfully install the LanSafe III for ManageWise

NLM on any file servers running Novell’s
SNMP.NLM that are protected by a UPS

b) Successfully install and integrate the LanSafe III
ManageWise Console on your management station

c) Install and start Windows on a workstation
d) Install the Novell ManageWise Console
e) Install the LanSafe III for ManageWise Console
1. Start NLM LS3NMS on any file servers where you

have installed it.
Type Load LS3NMS at the file server or from a
remote RCONSOLE session.
Repeat this step any time you install LanSafe III for
ManageWise on a file server.

2. Run the LanSafe III ManageWise Autodiscovery Tool
on any management stations where LanSafe III for
ManageWise has been installed.

Start the Novell NetWare Management System applica-
tion from the Novell-NMS program group on your
management station.

Verify that the SNMP Data Server is active after NMS
startup completes.

Verify that the LanSafe III ManageWise Autodiscovery
Tool is active after NMS startup completes. This tool first
polls the network after it starts executing, and continues
polling the network periodically to discover newly-
installed LanSafe III NMS file servers and add them to
your network map.

[To change the polling rate, double-click the
Autodiscovery Tool icon and enter a new value for the
polling rate on the dialog that subsequently appears. If
necessary, you may start the LanSafe III ManageWise
Autodiscovery Tool manually from the Novell-NMS
program group.]
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Verify that the UPS icons have been added to your
network map

1. After the LanSafe III for ManageWise Autodiscovery
Tool has run, open the network segment on your
NMS map for each file server where LanSafe III for
ManageWise has been installed.

Observe that one UPS icon appears on the network
segment for each file server where LanSafe III for
ManageWise is running.

Launch the LanSafe III ManageWise Console for the UPS
on any file server

1. Double-click the UPS icon on the map with the same
name as that of the file server you want to monitor.

TO REINSTALL FAILSAFE III
1. Be sure your LanSafe III files are not write-protected.
2. If you have a copy of LanSafe III in the Startup

folder, delete it before reinstalling.

Section 2  ◆  Installation
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LanSafe III consists of the Power Monitor and a Console.
To utilize LanSafe III, you must activate the Power
Monitor. For this reason, most users accept the Auto Load
on Startup default at installation.

Running in the background, the Power Monitor estab-
lishes communications with the uninterruptible power
system (UPS) and provides information and services to
the Console. The Power Monitor also watches the power
environment and provides alert processing, orderly
shutdown, and log functions. If a power emergency
develops, the Power Monitor icon [a screen message if
you are running LanSafe III for DOS] comes to the
foreground, and beeps and blinks until you open it [or
press CTRL-ESC in DOS].

After the Power Monitor establishes communications, the
Console is your primary interface for monitoring and
control. The Console communicates with the Power
Monitor, displays power conditions, and provides menu
access to dialog boxes where you can adjust program
settings, conduct hardware tests, reboot or shut down the
computer, and view power and battery management logs.

THINGS TO REMEMBER ABOUT
RUNNING LANSAFE III

◆ For full functioning of LanSafe III, a UPS must
support the node.

◆ Power monitoring occurs only after you start the
LanSafe III Power Monitor within the appropriate
operating system or environment.
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◆ If a system shutdown is necessary, LanSafe III saves
only named files. To avoid loss if a power failure
occurs, name any new files as soon as you open
them.

◆ For applications with automatic saving capability, set
the autosave time to a value less than the LanSafe III
power failure countdown time.

◆ To reconfigure LanSafe III, it is not necessary to
reinstall or reload. New configuration settings
become active when you close the dialog box.

◆ Control is limited to the computer on which you run
the Console and remote nodes for which you enter
the access code.

◆ Never try to run more than one copy of LanSafe III at
any one time.

◆ If you run LanSafe III in an OS/2, Windows, or
Windows NT operating system and want to switch to
a DOS application and keep your LanSafe III protec-
tion, run DOS within that system.

If you run LanSafe III in a DOS environment and
want to switch to OS/2, Windows, Windows 95, or
Windows NT, close the DOS Console and unload the
DOS Power Monitor.

◆ In LanSafe III for DOS workstations, shutdown
timing consists of wink time and power failure
countdown time. There is no time needed to down
system.

Section 3  ◆  Operation
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THINGS TO REMEMBER WHEN
RUNNING LANSAFE III IN A UPS
GROUP

◆ LanSafe III communications require that the UPS
group controller run whenever any group member
runs.

◆ The shutdown time for the UPS group controller
must be longer than the shutdown time for any
group member.

◆ Any group member can run a LanSafe III Console to
control and configure LanSafe III for all units within
the UPS group.

THINGS TO REMEMBER ABOUT
UPSs WITH DRY-CONTACT
INTERFACES

◆ UPSs with dry-contact interfaces support only
limited Console information.

◆ UPSs with dry-contact interfaces do not support
hardware tests and preventive maintenance.

◆ UPSs with dry-contact interfaces do not support the
Battery Management Log.

THINGS TO KNOW ABOUT RUNNING
LANSAFE III FOR MANAGEWISE

◆ LanSafe III for ManageWise provides the following
enhancements to the NMS management console:
Autodiscovery Tool, MIB browser profiles, NetWork
UPS Hardware Test Tool, Network UPS Preventive
Maintenance Test Tool, and LanSafe III ManageWise
Console.
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◆ The default LanSafe III for ManageWise Console
screen is the Data view. To see the PowerScope view,
click the PowerScope icon. To return to the Data
view, click the Power Status icon.

◆ To perform LanSafe III control operations, click the
appropriate icon on the LanSafe III ManageWise
Console.

◆ For help with a dialog box operation, press F1 or see
the Operations section of the LanSafe III Installation
and Operation Manual.

POWER MONITOR
Except for DOS, the maximized Power Monitor window
includes a menu bar and a status windows display. When
DOS users activate the Power Monitor screen, they see a
system prompt.

In addition, DOS users see a status message across the
bottom of their screen, indicating the current power
situation as LanSafe III reads it. Other users see the most
recent LanSafe III messages in their status window
display. For a list of messages, see appendix C.

If the latest entry indicates an abnormal power condition,
run the Console and check the UPS status.

Receiving Power Monitor Messages from Other
Network Nodes
Whenever a change in power status occurs, LanSafe III
can generate Power Monitor messages to network users
with Windows, OS/2, and UNIX systems. To modify the
list of users to receive broadcast messages from your
system, choose Customize Alerts from the Setup menu.

Receipt of broadcast messages varies with your system,
as follows:

◆ In OS/2 and UNIX, receipt of messages is automatic.

◆ In Windows 95, you must start WinPopup.

Section 3  ◆  Operation
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◆ In Windows NT, v. 4, you must either start
WinPopup (NT 4.0 or higher only) or run the Alerter
and Messenger services.

◆ In Windows 3.1x, you must start NetWare Popup
(nwpopup.exe).

To Manually Load and Unload the Power Monitor
See Table 3-1.

Table 3-1. Manual Start and Stop of Power Monitor

Node Type To Start To Shut Down
IBM OS/2 Run LS3.exe Select File/Exit

NetWare 386 or 4.x At file server, type At file server, type
File Server Load LS3 Unload LS3

Windows Workstation Open Power Monitor Choose File/Exit
icon, or run LS3W

Windows 95 Open the Program folder Choose File/Exit
Workstation on the Start menu and choose

Power Monitor from the
LanSafe III folder, or restart
your computer (if you
accepted the Auto Load on
Startup default at installation).

Windows NT System Service
Workstation Open the Services dialog Stop service

box from the Program
Manager Control Panel
start LanSafe III System
Service
Window
Open the Power Monitor Choose File/Exit
icon or run LS3.EXE.

DOS workstation In directory where Type LS3OFF
LanSafe III resides,
type LS3

If the Power Monitor does not establish communications
with the UPS, see the Troubleshooting Guide,
Appendix A.
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CONSOLE
The Console consists of a menu bar and a Console screen.
In OS/2, Windows, Windows NT, and Windows 95, the
Console opens in PowerScope view, as shown in
Figure 3-1. LanSafe III for DOS does not support the
Console.

Figure 3-1. LanSafe III for Windows PowerScope View

The Console menus are File, View, Setup, Maintenance,
Shutdown, Logs, and F1=Help. Each is described later in
this section.
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To Run the Console
Do one of the following:

◆ Choose Run Console from the Power Monitor menu
bar.

◆ Double-click the Console icon in the LanSafe III
program group (program folder in OS/2).

◆ In the directory where your LanSafe III files are
stored, start LS3CON (LS3CONW for Windows,
LS3CON95 for Windows 95).

For alternate methods for running the Console, see
below.

To Monitor LanSafe III on Another Node
Do one of the following:

◆ Start the Console, and select the node using the
Select Node dialog box.

◆ In the directory with your LanSafe III files, start
LS3CON NodeName (LS3CONW NodeName for
Windows, LS3CON95 NodeName for Windows 95).

To Control LanSafe III on Another Node
Do one of the following:

◆ Start the Console, choose Enter Access Code from the
File menu, enter the other access code, and select the
node using the Select Node dialog box.

◆ In the directory with your LanSafe III files, start
LS3CON /A=AccessCode NodeName (LS3CONW /
A=AccessCode NodeName for Windows,
LS3CON95/A=AccessCode NodeName for
Windows 95).
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To Control a Node in a Group Whose Access Codes Differ
from Yours
Do one of the following:

◆ Start the Console, enter the access code, and select
the desired node using the Select Node dialog box.

◆ In the directory with your LanSafe III files, start
LS3CON /A=AccessCode (LS3CONW /
A=AccessCode for Windows, LS3CON95/
A=AccessCode for Windows 95).

To Limit Your Build to Speed Network Polling
1. Create a text file in the directory where your

LanSafe III files are stored listing one network
segment per line.
To add a comment to a line, type # and your text. The
system will not read it.

2. In the directory where your LanSafe III files are
stored, start LS3CON/Networks=MYNETS.TXT
(LS3CONW/Networks=MYNETS.TXT for
Windows, LS3CON95/Networks=MYNETS.TXT for
Windows 95).
Rather than poll the entire network, LanSafe III polls
only the network segments on your list.
If you do not enter a command line parameter, the
Console attempts to read a file named
NETWORKS.TXT in the LanSafe III directory. If this
file does not exist, the entire network is polled.

FILE MENU
Use to select a node, enter an access code, and exit the
Console.

To Select a Node
1. Choose Select Node from the File menu to open the

Select Node dialog box.

Section 3  ◆  Operation



LanSafe III for Novell, Microsoft, and OS/2  ◆  05143916-003  ◆  B          25

2. In the node lists, highlight the node you wish to
control. The lists are labeled FileServers, Worksta-
tions, Bridges, Domain controllers, Other Servers, or
Requester.
If you highlight a node in a UPS group, you must
highlight the entire group.

Use the Networks list to change the lists of File Servers or
Domain Controllers, Other Servers, and Workstations or
Requesters. Choose Rebuild List to refresh the list.

3. Choose Select Node

To Enter an Access Code
1. Choose Enter Access Code from the File menu to

open the Enter Access Code dialog box.

2. Enter the access code.
To see the nodes on the network on the Select Node
Dialog box and to monitor the power situation of a
particular node, you must enter an access code. If you do
not enter an access code, your access is limited to your
local node. To control another network node, you must
enter the correct access code for that node.

To Exit the Console
Choose Exit from the File menu.

VIEW MENU
Use to select your Console interface with your UPS, either
PowerScope view or Data view. If your utility power is
3-phase, you can view by input and output phase.

N O T E
PowerScope view and Data view are limited
on UPSs with dry contact interfaces
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About PowerScope View and Data View
The PowerScope is a dynamic, functional block diagram
showing the flow of power from the utility, through the
UPS, and out to the load, with values for input, output,
and other data. Data view shows output and input power
in bar chart form, with text descriptions for battery and
operation status. Data view and PowerScope share the
same sections for node information and communications
status.

Node Information section. Node information includes the
node type and address, the software type and version,
and the UPS model name, numbers and revision.

NOTE:  UPSs with dry contact interfaces do not support
all information features.

Communications status section. Communications status
is a text message describing the state of current communi-
cations.

The PowerScope diagram reads from left to right. It
includes values for input voltage, output voltage, avail-
able run time, the current battery or ABM status, and the
current load %.

NOTE:  UPSs with dry contact interfaces do not support
the PowerScope display.

Volts In. The Volts In section on the left side of the screen
shows the voltage of utility power and a colored bar. The
color describes the power situation, either as acceptable
(green), near range limits (yellow), or out-of-range (red).
For the UPS to operate on utility power, the voltage must
be in the green range.

NOTE:  UPSs with dry-contact interfaces do not support
this feature.

In case of undervoltage or overvoltage, an alarm sounds
and the UPS switches to UPS battery power. The colors
on the display show the input power to be in the yellow
or red range. Save your work and close your files imme-
diately, then try to analyze and resolve the problem.

If the situation persists, contact your utility.
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Volts Out. The Volts Out section on the right side of the
screen shows the output voltage of on the UPS with a
colored bar. Colors have the same meaning as in the Volts
In section.

NOTE:  UPSs with dry contact interfaces do not support
this feature.

Use the Volts Out information and the % Load value to
evaluate the utilization of your UPS. If the % Load value
is in the yellow or red range, your power requirements
demand a UPS with a higher load capacity. If the load
value is in the red range, the UPS is overloaded, and a
computer shutdown will occur in one minute or less. If
the load value is in the green range, you are operating
safely within the load range of the UPS.

C A U T I O N
An extended red value is a cause for con-
cern. A system shutdown will occur in one
minute or less. Save your work and close your
files immediately, then try to analyze and re-
solve the problem.

NOTE:  UPSs with dry-contact interfaces do not support
this feature.

To Select Input and Output Phases for Viewing
1. Choose Input Phase 1, Input Phase 2, or Input

Phase 3 from the View menu.
2. Choose Output Phase 1, Output Phase 2, or Output

Phase 3 from the View menu.
Input and output phase numbers need not be the
same.

3. Choose either Data view or PowerScope from the
View menu.

To Open a View
Choose either Data or PowerScope from the View menu.
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SETUP MENU
Use to change communications ports, reconfigure shut-
down timing, set up a maintenance reminder, and change
access codes for a node or a network.

It is not necessary to reinstall or reload the LanSafe III
software. New configuration settings become active
immediately.

To Change Communications Ports
1. Choose Communications Port from the Setup menu

to open the Communications Port Setup dialog box.
All users but Novell file servers  Go to step 2.

Novell file servers :  Go to step 6.

2. All users but Novell file servers: Choose either
Standard or Custom.

3. If you choose Standard, a list of communications
ports becomes active. If you choose Custom, an edit
field becomes active.

4. If you selected Standard, highlight the port your
computer uses for serial communications with the
UPS. If you selected Custom, enter the device name.
See your communications port manufacturer ’s
hardware manual for information.

5. Choose OK to close the dialog box. (Skip steps 6-9)
Changes take effect at once.

6. Novell file servers :  Choose either COM1 IRQ4
Addr=03F8, COM2 IRQ3 Addr=02F8, or Custom.

7. If you selected COM1 IRQ4 Addr=03F8 or COM2
IRQ3 Addr=02F8, choose OK to close the dialog box.

8. If you selected Custom, the IRQ field and Addr edit
field become active and require you to make entries.
See your communications port manufacturer ’s
hardware manual for information.

9. Choose OK to close the dialog box.
Changes take effect at once.
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To Reconfigure Shutdown Timing
1. Choose Shutdown Timing from the Setup menu.

If your selected node is a standalone, the Shutdown
Timing Setup dialog box opens. If your selected node is a
UPS group, the UPS Group Shutdown Timing Setup
dialog box (Figure 3-2) opens.

Figure 3-2. UPS Group Shutdown Timing Setup dialog box

Each UPS group controller is listed. Below each UPS
group controller are the names of the group member
nodes preceded by a plus sign.

2. Enter values for wink time, power failure countdown
time, and time needed to down system.

Wink time eliminates nuisance messages from brief
power interruptions. Choose any integer between 1 and
999 (the default value is 5 seconds).



30

Power failure countdown time gives you time to finish
your work and save your files. Each minute, you are
informed of the time remaining until shutdown. Choose
any integer from 1 to 999 (the default value is 5 minutes).

Time needed to down system allows the Power Monitor
to log off users, terminate any applications that are still
running, and close all files in the computer’s file system.
The time may be any integer from 1 to 999 (the default
value is 90 seconds).

Note that if you are configuring a UPS group shutdown
time you cannot set the shutdown time for the UPS group
controller at a value less than the shutdown time for any
group member. To reduce the shutdown time for the UPS
group controller to a value less than the shutdown time
for a group member, you must first reduce the shutdown
time for the member.

3. Choose OK to close the dialog box.
Changes take effect at once.

Things to Remember About Shutdown Timing
◆ The length of battery protection increases as the load

on the UPS decreases.

◆ After a power outage, another outage could occur
before the UPS batteries fully charge. For complete
system fault tolerance, set the countdown time at a
value small enough to allow battery reserve for at
least two shutdowns.

◆ It is extremely important that the UPS not shut off
until all applications are terminated and all files in
the file system are closed. Set the time needed to
down the system at a value large enough to assure
that the Power Monitor software has time to shut
down a worst-case computer environment.

To Set Up a Maintenance Reminder Schedule
1. Choose Maintenance Schedule from the Setup menu

to open the Maintenance Schedule Setup dialog box.
2. Choose Enabled to set a schedule or Disabled if you

do not want a reminder to appear in the Power Log
at set intervals.
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3. If you choose Enabled, the Days Between Runs field
become active. Use the arrow keys to specify the
interval (in days) between maintenance reminders.
This may be any number between 30 and 999 (the
default is 90).

To Customize Alerts
The Customize Alerts feature enables you to change the
text for alert messages and to cause a particular alert to
execute a command or send a message to another system
such as a pager.

In all cases, the basic procedure is as follows:

1. Choose Customize Alerts from the Setup menu to
open the Customize Alerts dialog box (Figure 3-3).

Figure 3-3. Customize Alerts Dialog Box
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2. Select one or more messages from the scroll list at the
left side of the box, or choose Select All.
If you select only one message, or if all selected
messages have the same text, a customizable mes-
sage for a selected alert appears in the Message Text
list.

3. Follow the procedure for the customization you wish
to make (see below).

4. Choose OK to enter the change, Defaults to return
the settings to their default position, or Cancel to
close the dialog box.

To Change the Text for a Message
Enter a new message in the Message Text list, or translate
the message to another language. For a list of alert
messages, see appendix C.

To Execute a Command when an Alert Occurs
1. Put a check in the Execute Command box.
2. Click the Execute Command edit field.
3. Enter a fully qualified path name for the command

and any parameters, using the variables that appear
in the Substitution Variables box.

If you selected multiple alerts and the alerts do not
all execute the same command, the check box and
field are gray. To set multiple alerts to execute the
same command, select the alerts and complete this
field.
To change the action the system takes in an alert
situation, choose a message and type a new com-
mand in the Execute Command edit field. If the
command is a DOS executable or batch file, you must
include the extension, for example, EXECUTE.EXE
for a DOS executable or FILE.BAT for a batch file. For
help in writing a DOS command or a batch file, see
your DOS documentation or on-line help.
To test operation of this command in real time,
choose the Test button.
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To Send E-Mail

N O T E
To receive e-mail, a Windows 3.1x node or
a Windows 95 node in a Novell network must
run a messaging application program inter-
face (MAPI)-capable messaging software pro-
gram such as MS  Exchange (indigenous to
Windows 95) or MS Mail. An OS/2 node
must install vendor independent messaging
(VIM) software such as Lotus CC:Mail. The
CC:Mail Post Office must be level 6 or above,
and you must add a mailbox named lansafe
with the password lansafe.

1. Select a message in the message list.
2. Check the E-mail box.
3. In the text edit field, type the e-mail addresses of the

persons to whom you want this message sent should
it be necessary to send it. Separate multiple ad-
dresses by commas.
If multiple alerts are selected, the check box is gray
unless all the alerts send e-mail to the same
destinations.
To set multiple alerts to send e-mail to the same
users, select the alerts and enter their names in this
field.

4. Choose OK to enter the message or Cancel to close
the dialog box without changing the system.

C A U T I O N
Choose Defaults only to return all messages
and strings (including saved messages and
strings) to their factory settings.

The e-mail recipient receives the message via the
recipient’s mail system. The sender may send e-mail by a
different mail system. Recipients should be sure their
systems are set up to receive e-mail from all potential
senders. See documentation for the specific systems for
details.
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To test operation of this command in real time, choose the
Test button for E-Mail.

To Send a String to a Modem
1. Put a check in the Send String to Modem check box.
2. Specify the modem port by choosing Comm Port to

open the Communications Port dialog box.
3. Click the text field.
4. Using the variables that appear in the Substitution

Variables box, enter a string to be sent. See Creating a
Modem String.
If you select multiple alerts, the check box and text
field are blank unless all the alerts send the same
string to the modem.
To set multiple alerts to send the same string to the
modem, select the alerts and enter the string.
To test operation of this command in real time,
choose the Test button.

Creating a modem string
Exact instructions for creating a modem string vary from
carrier to carrier. However, the following example, which
assumes SkyPage and the Windows Terminal program,
should provide the essential details for you to create a
modem string in a system other than SkyPage and
Windows, if necessary. After creating your modem string,
be sure to test it.

Characters in bold are commands from the software and
characters in UNDERLINED-ITALIC are responses from
the remote services.

N O T E
If your service does not handle alphanumeric
messages, check with your service.

ATZ (Return & Wait)
OK
ATDT918007599673 (Return & Wait)
CARRIER 2400
PROTOCOL: LAP-M
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COMPRESSION: NONE
CONNECT 2400/ARQ (Return & Wait)
SKYTEL REMOTE TERMINAL
PAGER ID: 3024258 (Return)
FUNCTION: (Return)
ENTER ALPHA MESSAGE: TEXT HERE  (Return)
SEND ?: (Return)
FUNCTION: 99 (Return)

In this case the dialing string would be as follows:

ATZ$RET$WAIT$ATDT18007599673$RET$WAIT$RET$WAIT12345678$RET$TEXT
HERE$RET$RET99$RET

The following table shows definitions of the string and
variables:

String Variables
ATZ Soft reset modem and restore active profile 0*.

$RET Carriage Return (Enter).

$WAIT Wait for any string to return from other modem.

ATDT Dial in touch-tone mode (Always followed by the phone
number with any necessary prefixes or suffixes). i.e.
918005551212. 9, to get an outside line,  1 for long
distance and 8005551212 is the area code and phone
number of the modem/service you wish to call.

TEXT HERE Pertinent text should be inputted exactly as you would
like it to display on the pager. You can use one of the
wild cards listed below to substitute from data collected
from the connected CPU.

$MSGNUM The actual number of the alarm from list or manual.

$MACHINE The name given to the CPU (Not by LanSafe III or
FailSafe III software).

$MESSAGE Repeat the message string set up in the “Message Text”
window. Can change language and include variables
also.

$MINUTES Minutes remaining until shutdown.

*Profile should be pre-configured for your service (bits,
parity, stop bits, and baud rate (that is, 8, none, 1, 2400).
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To Set a Delay Time for an Alert Message
When alert situations are resolved, notification is immedi-
ate, but when an alert situation occurs, you can set a
message delay. If the situation is resolved before the delay
time (usually a few seconds) expires, you are not inter-
rupted. If delay time applies to the selected message
(message 4 and all even-numbered messages from 10 to
70), the Delay Time (seconds) edit field becomes active.

1. Use the up and down arrows to select a delay time.
For message 14, Utility Power Failure, the Delay
Time is the same as Wink time which you set under
the Shutdown Timing dialog box.

To Send Broadcast Messages to Logged-On Users

N O T E
This feature is not available in Windows 95.

1. Put a check in the Broadcast Message to Users check
box.

2. Choose the users to receive broadcast messages,
using the All radio button to send a message to all
users or the Some radio button to send a broadcast
message to those you specify in the list box.
If you select multiple alerts, the check box is gray
unless the alerts send broadcast messages to the
same users.

3. To set multiple alerts to send broadcast messages to
the same users, select those alerts and complete the
information in this area.
To test operation of this command in real time,
choose the Test button. Users who are not logged in
at the time of the alert do not receive a message.

To Configure Load Segments for Load Shedding
N O T E

This feature is supported only by certain UPSs.
See your UPS manual for details.
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Use load shedding to set a shorter shutdown delay time
or a later restart time for non-essential peripherals,
extending the run time of your computer. If you do not
enable load shedding, your computer and all peripherals
attached to your UPS shut down at the end of power
failure countdown time and restart immediately after a
power failure when power is restored.

To enable load shedding, attach your computer and
peripherals to the numbered load segment receptacle
groups on the rear of your UPS, and configure the loads
in your software.

To Configure Load Segments in Your Software
1. Choose Load Segment Configuration from the Setup

Menu. The Load Segment Configuration dialog box
opens.

2. In the Load Segment/Computer List with icons for
Entire UPS, your computer, Load Segment 1 and
Load Segment 2, drag the icon for your computer to
the Load Segment to which it is physically attached
on the back of your UPS. Your non-essential periph-
erals should be physically attached to the other Load
Segment on back of the UPS.

To Shorten a Shutdown Delay for Non-Essential Peripherals
1. In the Load Segment Configuration dialog box,

choose the Load Segment for the devices other than
your computer.

2. Set a Power Failure Run Time, using the Power
Failure Run Time scroll list.

To Vary Device Restart
1. In the Load Segment Configuration dialog box,

choose the Load Segment for the devices other than
your computer.

2. Set a Restart Delay, using the Restart Delay [seconds]
scroll list.
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N O T E
You can also set this delay by using the Re-
start Delay dialog box. Choose Restart Delay
from the Setup menu.

To Set a Restart Delay
This feature is supported only by certain UPSs. See your
UPS manual for details.

Specify a restart delay for any load segment with equip-
ment you do not need immediately upon reboot. Servers
or your computer can be left with a zero restart delay (the
default), while workstations or peripherals can be pro-
grammed with a later restart delay.

N O T E
Restart delay occurs only when the system
restarts after LanSafe III shuts down the UPS
in a power outage. Restart delay does not
occur when you use LanSafe III to reboot the
system.

To Delay Restart of Non-Essential Peripherals
1. Choose Restart Delay from the Setup Menu. The

Restart Delay dialog box opens.
2. Select the Load Segment to which your computer is

attached.
The computer name appears in the Attached Com-
puters box.

3. Set a restart delay, using the Restart Delay [seconds]
scroll list.

N O T E
You can also set this delay by using the Load
Segment Configuration dialog box. Choose
Load Segment Configuration from the Setup
menu.
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To Change the Access Code for a Node
1. Choose Access Code from the Setup menu to open

the Configure UPS Access Code dialog box.
2. Enter the new access code.

3. Verify the new access code.
This code change applies to the node whose name and
address appear in the Node Information section of your
Console display.

To Change the Access Code for a Network
1. Choose Access Code for Network from the Setup

menu  to open the Configure UPS Access Code for
Network dialog box.

2. Use the Networks list and the Files Servers and
Workstations check boxes to compile a list of nodes
(Power Monitors For Access Code Change) to which
the new access code is to apply.

3. Enter the new access code.
4. Verify the new access code.

To Configure the Network UPS Access Code for a UPS
Group
When you open the Configure Network UPS Access Code
dialog box, the list box shows UPS group members. The
new access code applies to the group controller and its
members.

MAINTENANCE MENU
Use to activate UPS testing and preventive maintenance
routines.

To Test Hardware for the Selected Node
1. Choose Test Hardware from the Maintenance menu

to open the Test Hardware dialog box.
2. Choose Start.
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N O T E
UPSs with dry-contact interfaces do not sup-
port hardware tests.

The test places the UPS on battery for several seconds.
During this time, the UPS verifies the battery and internal
circuit operation. It displays the current testing status.

To close the dialog box without starting a test, choose
Exit. To close the Test Hardware dialog box during a test,
start the test and choose Exit. The test continues.

To Test Hardware for Network
1. Choose Test Hardware for Network from the Mainte-

nance menu to open the Test Hardware for Network
dialog box.

2. Use the Networks list and File Servers and Worksta-
tions check boxes to create a List of Power Monitor
Nodes to Test.

3. Choose Start.
A message lets you know how much time has passed and
when testing finishes.

To close the dialog box without testing, choose Exit. To
close the Test Hardware dialog box during a test, start the
test and choose Exit. The test continues.

To Run Preventive Maintenance
1. Choose Preventive Maintenance from the Mainte-

nance menu to open the Preventive Maintenance
dialog box.

2. Choose Start.

N O T E
UPSs with dry-contact interfaces do not sup-
port preventive maintenance.

The test places the UPS on battery for several seconds.
During this time, the UPS verifies the battery and internal
circuit operation. It displays the current testing status.
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To close the dialog box without starting a test, choose
Exit. To close the Preventive Maintenance dialog box
during a test, start the test and choose Exit. The preven-
tive maintenance continues.

To Run Preventive Maintenance for Network
1. Choose Preventive Maintenance for Network from

the Maintenance menu to open the Preventive
Maintenance for Network dialog box.

2. Use the Networks list and File Servers and Worksta-
tions check boxes to create a List of Power Monitor
Nodes to Test.

3. Choose Start.
A message lets you know how much time has passed and
when preventive maintenance finishes.

To close the dialog box without testing, choose Exit. To
close the Preventive Maintenance dialog box during
maintenance, start the run and choose Exit. The preven-
tive maintenance continues.

SHUTDOWN MENU
Use to shut down the selected Power Monitor node, and
unload the Power Monitor program at the selected node.

N O T E
Exercise extreme caution in using the Shut-
down menu. If a server is shut down from the
LanSafe III Console, all users on the server
are forcibly logged out, and work in progress
may be lost.
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To Unload the Power Monitor
Choose Unload Power Monitor from the Shutdown
menu.

When a UPS group member chooses Unload Power
Monitor from the Shutdown menu, the UPS Group
Unload dialog box opens. You can unload UPS group
members, but if you unload the UPS group controller you
automatically unload the entire group.

To Shut Down and Reboot the System
1. Choose Shutdown/Reboot System from the Shut-

down menu  to open the Shutdown/Reboot dialog
box.

2. For an automatic reboot after shutdown, choose
Reboot. For a shutdown of a specific length, choose
Timed. For a system shutdown until the UPS is
restarted, choose Permanent.

3. Choose Shutdown.

To Shut Down a Load Segment on a Scheduled Basis
This feature is supported only by UPSs supporting load
shedding.

1. Choose Weekly Schedule from the Shutdown menu.
The Weekly Shutdown Schedule dialog box opens.

2. Use the <<==Day and Day==>> controls to change
to the desired day of the week.

3. Select Entire UPS or the Load Segment to which the
shutdown should apply.

4. Click the hour or half-hour for Entire UPS or a Load
Segment when you want the shutdown to start.
Boxes are numbered for a 24-hour clock system.

5. Click the hour or half-hour for Entire UPS or a Load
Segment when you want the shutdown to end, and
all boxes in between.
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LOGS MENU
Use to view or clear the Power Log and Battery Manage-
ment Log for the selected node, and to export the log text
to an ASCII file which you can print.

To Access the Power Log
Choose View/Clear Power Event Log from the Logs
menu.

Choose Clear Log to delete all entries in the log. The log
is not cleared until you answer a prompt confirming the
selection. One new entry is inserted indicating the date
and time that the log file was cleared.

Choose Go To Battery Log to open the Battery Manage-
ment log. To open the log at an entry close in time to a
Power Log entry, highlight the Power Log entry before
selecting Go To Battery Log.

Choose Export to copy the Power Log to an ASCII text
file which you can open in a text or word processor
program for printing and saving.

To Access the Battery Management Log
Choose View/Clear Battery Management Log from the
Logs menu.

N O T E
UPSs with dry-contact interfaces do not sup-
port the Battery Management Log.

Choose Clear Log to delete all entries in the log. The log
is not cleared until you answer a prompt confirming the
selection. One new entry is inserted indicating the date
and time that the log file was cleared.

Choose Go To Power Log to open the Power log. To open
the log at an entry close in time to a Battery Management
Log entry, highlight the Battery Management Log entry
before selecting Go To Power Log.

Choose Export to copy the Battery Management Log to an
ASCII text file which you can open in a text or word
processor program for printing and saving.
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F1 = HELP MENU
Use to access on-line help and see the version of the
software and the copyright.

To Access On-Line Help
Choose General Usage from the Help menu (or press F1).

To Check the Software Version
Choose About from the Help menu to open the About
LanSafe III dialog box.

The dialog box contains information about the version of
the software and the copyright. Choose OK to leave the
About dialog Box.



LanSafe III for Novell, Microsoft, and OS/2  ◆  05143916-003  ◆  B          45

TROUBLESHOOTING

If LanSafe III fails to perform as it should, here is a list of
things to check:

1. Review the lists in Running LanSafe III, Things To
Remember When Running LanSafe III in a UPS
Group in Section 3, Operations.

2. Review the system requirements for file servers and
workstations in Section 2, Installation.

3. Be sure the communication port used on your
computer is the one selected under the Setup menu.

4. Be sure only one copy of the Power Monitor is
running.

5. Be sure you have logged on to your network in
accordance with the correct procedures.

6. See Table A-1.
To reinstall, see Section 2, Installation.

Table A-1. Troubleshooting LanSafe III for Novell NetWare

Problem Possible Cause Solution
Message: Must log on You are not logged into Log on, using account with
to server with a file server SUPERVISOR rights
SUPERVISOR rights Account you logged on to Log on, using account with

lacks SUPERVISOR rights SUPERVISOR rights

I do not see file server You are not logged on or Log on or attach to server,
I want to install on list attached to file server using account with
displayed by SUPERVISOR  rights
LanSafe III diskette The account you are Log in or attach to server you

logged or attached to want to install, using account
does not have with SUPERVISOR rights
SUPERVISOR rights
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Problem Possible Cause Solution
Message: Installation unsuccessful Re-install
Configuration User installed for Assign SUPERVISOR
file error LanSafe III lacks rights to user

SUPERVISOR rights

Installation successful, Power Monitor not Start Power Monitor
but Console can’t see loaded after installation
node

Message: Unable to Software not running Start Power Monitor
Contact Power Monitor

Message: Cannot Group Controller not Start LanSafe III on Group
contact UPS Group running LanSafe III Controller node
Controller

Message: Comm Another hardware device Reconfigure LanSafe III and
port unavailable configured with same communication port

IRQ or I/O address as hardware with different
LanSafe III addresses

Communications error LanSafe III and interface Reconfigure
message; or, power cables configured on communications port
failure or low battery different communication
messages despite no ports
apparent failure; or, Interface cable not See UPS Hardware
no messages when connected, secure, or installation manual
power failure is properly installed
simulated

Appendix A  ◆  Troubleshooting
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GLOSSARY

This glossary defines LanSafe III terms and other techni-
cal terms as used in LanSafe III. For definitions of more
general terms, see a standard computer reference.

ABM™
The abbreviation for Advanced Battery Management, and
a trademark of Deltec Electronics. ABM is a proprietary,
microprocessor-based, state-of-the-art system for moni-
toring and managing UPS batteries, with such features as
quick recharging, doubled battery life, and up to 60 days
of early warning before your batteries need replacement.
ABM prevents overcharging and accelerated battery
aging by not constantly charging the battery.

ACCESS CODE
A means of facilitating the use of LanSafe III software,
and of preventing unauthorized shutdowns and
disabling.

AUTODISCOVERY TOOL
A LanSafe III for ManageWise background operation, it
adds the File Server/UPS identification to the icon node
line of network hardware on the Ethernet logical map.
Executed at NMS startup. To display the LanSafe III
ManageWise Console, double-click the File Server/UPS
node icon.

BATTERY MANAGEMENT LOG
A record of ABM or Battery status whenever the ABM or
battery changes state. Records include log started, charg-
ing, discharging, floating (meaning battery is receiving
only a nominal charge), log stopped, and log cleared.
ABM systems include a “resting” message when the
battery is receiving no charge. This ABM feature reduces
battery wear.
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BLACKOUT
A complete loss of utility power to the UPS.

BOOST AND BUCK
A proprietary line regulation process used when an
overvoltage or undervoltage situation occurs in the UPS.
Undervoltage is boosted to make it greater and overvolt-
age is bucked to reduce it, thus reducing reliance on the
battery.

BROWNOUT
A condition where the utility power voltage drops below
the lower limit of the UPS, causing a switch to battery
power via the inverter.

BYPASS CIRCUITRY
A feature of some UPSs which causes your system load to
be powered directly from the UPS input. See your hard-
ware manual for details.

CHARGER
See Rectifier/Charger.

CONSOLE
Your primary interface with the UPS through LanSafe III.
It allows you to view and control the power environment
of every node where the Power Monitor is running.

CONSOLE (LANSAFE III FOR MANAGEWISE)
Primary interface for viewing and controlling the UPS
power environment. Requires ManageWise be launched
and the SNMP Data Server be initialized. UPS power
environment viewing is through the Power Status and
PowerScope icons to the right of the Console. Control is
through the Configuration Information, Test Hardware,
Preventive Maintenance, Node Shutdown, and Unload
Software icons. Further information is available through
the Power Log, Battery Log, and About icons.
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DATA VIEW
A Console display of colored bar graphs and text to give
you a concise but comprehensive overview of the UPS
hardware and the utility power situation. Values are
updated at various intervals of less than 30 seconds to
reflect a current picture of the environment. See
PowerScope.

DOMAIN
In Windows NT, a group of computers with its own
name, database, and security policy. The computers are
classified as the domain controller, other servers (when
used), and workstations.

DOMAIN CONTROLLER
In Windows NT, the server that maintains the domain’s
security policy and master database, and authenticates
domain logons. Domain controllers run Windows NT
Advanced Server. A domain may include other servers
which receive copies of the domain’s security policy and
databases.

EMERGENCY SHUTDOWN
An automatic feature in the event of a UPS low battery or
overload condition. The Power Monitor begins to shut
down applications and files. Shutdown time is UPS-
specified and depends on your UPS. Refer to your UPS
manual. See also Orderly Shutdown.

FILTERS
The UPS components that prevent corruption of system
data by helping to ensure that transients and high fre-
quency noise are reduced or eliminated.

HARDWARE TEST
Places the UPS on battery power for several seconds to
verify proper operation of the hardware.

INVERTER
The UPS component that converts DC from your UPS
battery to AC for powering your system.
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LOAD SHEDDING
A UPS feature enabling users to remove connected
devices from the load. Load shedding extends the power
of your UPS battery.

MIB BROWSER PROFILES
A LanSafe III for ManageWise feature providing data on
UPS operating characteristics including battery, alarm,
power, and configuration. Select any file to open a data
window. Each profile begins with the same identifier.

NETWORK UPS HARDWARE TEST TOOL
A LanSafe III for ManageWise tool for testing network
UPS hardware. Accessed through the Test Hardware icon
on the Console.

NETWORK UPS PREVENTIVE MAINTENANCE TEST TOOL
A LanSafe III for ManageWise tool for running preventive
maintenance on network file servers. Accessed through
the Console Preventive Maintenance icon.

OTHER SERVER
In Windows NT and Lan Server, the computer that
receives a copy of the domain’s security policy and
domain databases, and authenticates network logons.
Other servers are distinguished from the domain control-
ler which maintains the domain’s security policy and
master database. Other servers run Windows NT Ad-
vanced Server.

ORDERLY SHUTDOWN
The LanSafe III process, activated after a utility power
failure, which protects users and file systems from lost or
corrupted data. LanSafe III saves work in progress and
shuts down your system in accordance with the shut-
down timing you specify.

% LOAD
A percentage of the UPS’s calculated full load capacity.

Appendix B  ◆  Glossary
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POWER FAILURE COUNTDOWN TIME
The time in minutes after the end of wink time that the
LanSafe III software waits before starting a shutdown
sequence. Use this time to save your work and log out
before your computer goes down.

POWER LOG (POWER EVENT LOG)
A record of significant power events, including power
outages, low battery and overload indications, hardware
self-test results, software loads and unloads, serial
communication connections and failures, and preventive
maintenance reminders.

POWER MONITOR
The LanSafe III software component that communicates
with your UPS to monitor the status of the input utility
power, output load and condition of the UPS hardware.
The Power Monitor also watches the power environment
and provides alert processing, orderly shutdown, and
logging functions.

In Windows NT, the Power Monitor consists of a
Windows NT system service and window. The system
service communicates with your UPS and provides alert
processing, orderly shutdown of your file system, and
logging functions. In the event of a utility power failure
or other significant power event, the icon for the window
appears on top of your currently active window and
beeps until you open it. If a shutdown is necessary, the
window shuts down your applications.

POWERSCOPE
A full-system diagram with a full color display of your
power. It is a View menu option on Consoles. Values are
updated at various intervals of less than 30 seconds to
reflect a current picture of the power environment.

PREVENTIVE MAINTENANCE
A procedure by which the UPS is placed on battery power
for several seconds to verify proper operation of your
hardware. If your UPS does not support preventive
maintenance, a hardware test is run.
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RECTIFIER/CHARGER
In some UPSs, a rectifier converts AC to DC. In others, a
charger which includes a rectifier converts AC to DC.

REQUESTER
A computer running OS/2. See Workstation.

RESTART DELAY
A control of the Load Segment Configuration and Restart
Delay dialog boxes used to bring up a server before
workstations, or to bring up peripherals after a worksta-
tion or workstations have been brought up.

RUN TIME
Maximum battery time available to support your system
until inverter shutdown, based on current load and UPS
conditions.

SURGE CONDITION
A situation in which utility power voltage exceeds the
upper limit of the UPS, causing a switch to battery power.

TIME NEEDED TO DOWN SYSTEM
The time in seconds from when LanSafe III begins to shut
down your system until the power from the UPS shuts
off.

UPS
Uninterruptible power system.

UPS GROUP–GROUP CONTROLLER–GROUP MEMBERS
When one UPS supports more than one computer (either
servers or workstations), the configuration is called a UPS
group. The one computer in the UPS group that is physi-
cally attached to the UPS communications cable is called
the UPS group controller. All other computers powered
by the UPS are called group members.

WINK
A brief interruption of utility power caused either by a
blackout, a brownout, or a surge condition.
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WINK TIME
The number of seconds after a utility power failure that
the LanSafe III software waits to inform you that the
system will be shutting down. This delay eliminates
nuisance messages from brief power interruptions.

WORKSTATION
A computer running DOS, Windows, Windows 95,
Windows NT or OS/2. In Windows NT, the domain
controller and other servers run Windows NT Advanced
Server. See Requester.
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N O T E S :
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CUSTOMIZABLE
ALERTS

0 $MACHINE is on battery ... shutdown in $MINUTES
mins

1 $MACHINE will shut down in 1 min
2 $MACHINE shutdown has been cancelled
3 $MACHINE is now shutting down
4 Unable to contact UPS group controller
5 Contact with UPS group controller established
6 LanSafe III Power Monitor loaded
7 LanSafe III Power Monitor unloaded
8 Time to run preventive maintenance
9 Communications port is unavailable

10 Communications failure with UPS
11 Communications established with UPS
12 Abnormal operation
13 Abnormal operation resolved
14 Utility power failure
15 Utility power failure resolved
16 Low battery
17 Low battery resolved
18 Bypass condition
19 Bypass condition resolved
20 Battery disconnect
21 Battery disconnect resolved
22 Backfeed contact failure
23 Backfeed contact failure resolved
24 Abnormal battery discharge
25 Abnormal battery discharge resolved
26 Battery fuse failure
27 Battery fuse failure resolved
28 Abnormally low battery
29 Abnormally low battery resolved
30 DC overvoltage
31 DC overvoltage resolved
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32 Bypass fuse failure
33 Bypass fuse failure resolved
34 Abnormal battery charge
35 Abnormal battery charge resolved
36 Battery failure
37 Battery failure resolved
38 Cabinet overtemperature
39 Cabinet overtemperature resolved
40 High utility frequency
41 High utility frequency resolved
42 Low utility frequency
43 Low utility frequency resolved
44 Utility ground failure
45 Utility ground failure resolved
46 Inverter fuse failure
47 Inverter fuse failure resolved
48 Inverter overvoltage
49 Inverter overvoltage resolved
50 Inverter overtemperature
51 Inverter overtemperature resolved
52 Inverter undervoltage
53 Inverter undervoltage resolved
54 Inverter power off
55 Inverter power off resolved
56 Oscillator failure
57 Oscillator failure resolved
58 UPS overload
59 UPS overload resolved
60 Rectifier power off
61 Rectifier power off resolved
62 Rectifier fuse failure
63 Rectifier fuse failure resolved
64 Rectifier overtemperature
65 Rectifier overtemperature resolved
66 Static switch overtemperature
67 Static switch overtemperature resolved
68 Disabled UPS condition
69 Disabled UPS condition resolved
70 High utility voltage
71 High utility voltage resolved
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Index

A

ABM, 47
ABM status, 26
About LanSafe III dialog box, 44
About option, 44
About PowerScope View and Data View, 26
Access Battery Management Log, 43
Access code, 3, 18, 24, 47

to change for network, 39
to change for node, 39
to enter, 25

Access Code option, 39
Access On-line Help, 44
Access Power Log, 43
Addr field, 28
Advanced Battery Management, 47
Alert Messages list, 32
Alerts

executing a command, 32
messages, 36
to customize, 31

All radio button, 36
Auto Load on Startup, 17
Automatic saving, 18

B

Battery Management Log, 43
to access, 43

Battery status, 26
Blackout, 48
Boost, 48
Bridges, 25
Broadcast Message to Users, 36
Brownout, 48
Buck, 48
Bypass Circuitry, 48

C

Cable
communications, 4, 8, 9, 10, 46, 52
Windows NT, 12

Change Access Code for a Network, 39
Change Access Code For a Node, 39
Change communications port, 28
Change message text, 32
Charger, 48, 52
Charging, 47
Clear Log, 43
Comm Port (Send String to Modem), 34
Command

to execute when an alert occurs, 32
Communications cable,

4, 8, 9, 10, 11, 46, 52
Communications port, 11, 46

COM1 IRQ4 Addr=03F8, 28
COM2 IRQ3 Addr=02F8, 28
to change, 28

Communications status, 26
Configure Network UPS Access Code, 39
Configure UPS Access Code dialog box, 39
Configure UPS Access Code for Network dialog

box, 39
Console, 22, 48

Data view, 25
functions, 17
interface with UPS, 25
PowerScope view, 25
to exit, 25
to run, 23

Control LanSafe III on another node, 23
Control node with different access code, 24
Custom, 28
Customizable alerts list, 55
Customizable responses and commands, 1
Customize alerts, 31
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D

Data view, 49
description, 26

Days Between Runs, 31
DEC Alpha, 5

Directory, 13
DecAlpha environment, 1
Delay Time, 36
Device Name, 28
Dialog boxes

About LanSafe III, 44
Communications Port, 34
Communications Port Setup, 28
Configure Network UPS Access Code, 39
Configure UPS Access Code, 39
Configure UPS Access Code for Network, 39
Enter Access Code, 25
Load Segment Configuration, 38
Maintenance Schedule Setup, 30
Power Log, 43
Preventive Maintenance, 40
Preventive Maintenance for Network, 41
Restart Delay, 38
Select Node, 24
Shutdown Timing Setup, 29
Shutdown/Reboot, 42
Test Hardware, 39
Test Hardware for Network, 40
UPS Group Shutdown Timing Setup, 29
UPS Group Unload, 42

Disabled, 30
Discharging, 47
Domain, 49
Domain Controller, 49
Domain Controllers, 25
DOS

shutdown timing, 18

DOS Workstation
install path, 13

E

E-Mail
to send, 33

Emergency Shutdown Domain, 49
Enabled, 30
Enter Access Code, 23, 24, 25

dialog box, 25
Enter an Access Code, 25
Entire UPS

load segment configuration, 37
weekly shutdown, 42

Execute Command, 32
Exit, 25, 40
Exit button, 40, 41
Exit Console, 25
Export, 43
Export log, 1

F

F1 = Help menu, 44
File menu, 24
File Servers, 25
File Servers check box, 39, 40, 41
Filters, 49
Floating, 47

G

Generic dry-contact UPS users
hardware tests, 19

Glossary, 47
Go To Battery Log, 43
Go To Power Log, 43
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H

Hardware for network
to test, 40

Hardware Test, 49
for selected node, 39

Hardware tests
dry-contact UPSs, 19

I

IBM, 1, 5
Input Phases

to select, 27
Input voltage, 26
Inverter, 48, 49
IRQ field, 28

L

Limit your build, 24
List of Power Monitor Nodes to Test, 41
Load Segment

load segment configuration, 37
Load segment, 36

To Shut Down on a regular basis, 42
weekly shutdown, 42

Load Segment Configuration dialog box, 38
Load Segment/Computer List, 37
Load Segments, 37
Load segments, 1

software configuration, 37
Load shedding, 37, 50

to enable, 37
Logs menu, 43
Lotus CC:Mail, 33

M

Macintosh, 3
Maintenance menu, 39
Maintenance Reminder Schedule

to set up, 30
Maintenance Schedule Setup dialog box, 30
Manual load and unload, 21
MAPI, 33
Menus

F1 = Help, 44
File, 24
Logs, 43
Maintenance, 39
Setup, 28
Shutdown, 41
View, 25

Message Text list, 32
Messages

Changing text, 32
from other nodes, 20
to change timing, 36

Microsoft, 5
Modem

to send a string to, 34
Modem string

to create, 34
Modem/pager/fax capability, 1
Monitor LanSafe III on another node, 23
MS  Exchange, 33
MS Mail, 33
Multiple alerts, 32
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N

NetWare Server
install path, 13

Network hardware test, 40
Network UPS Access Code for a UPS

to configure, 39
Networks list, 25, 39, 40, 41
Node

to select, 24
Node information, 26
Node Information section, 39
Novell NetWare

system requirements, 7, 10
Novell Netware, 1, 3, 5

O

Open a view, 27
Open Power log, 43
OS/2, 1, 3

system requirements, 7, 8
OS/2 Requester/Server

install path, 13
Other Servers, 25
Other-Vendor UPSs, 12
Output phases

to select, 27
Output voltage, 26
Overvoltage, 26, 48

P

Percent Load, 50
Power failure countdown time,

18, 29, 30, 37, 51
Power Failure Run Time, 37
Power Log, 30, 43, 51

to access, 43

Power Monitor, 51
functions, 17
To manually load and unload, 21
To Unload, 42

Power Monitor Nodes to Test, 40
Power Monitor window

in Windows, 20
Power Monitors For Access Code Change, 39
Power Up, Power Down, 1
PowerScope

description, 26
Preventive Maintenance, 51

dialog box, 40
to run, 40

Preventive Maintenance for Network, 41
dialog box, 41
to run, 41

R

Rebuild List, 25
Reconfigure LanSafe III, 18
Reconfigure shutdown timing, 29
Rectifier, 48, 52
Reinstallation, 16
Remote Access and Control, 3
Requester, 25
Restart Delay, 37, 38
Restart delay, 37, 52

to set, 38
Resting, 47
Run Console, 23
Run Preventive Maintenance, 40
Run Preventive Maintenance for Network, 41
Run time, 26, 52
Run Workstation, 52

Index
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S

Saving
automatic, 18
named files only, 18

Schedule maintenance reminders, 30
Select a node, 24
Select input and output phases, 27
Select Node, 23
Select Node dialog box, 24
Selected Node

To test hardware for, 39
Send String to Modem check box, 34
Setup menu, 28
Shut down or reboot, 42
Shut down Power Monitor node, 41
Shutdown button, 42
Shutdown delay

to shorten, 37
Shutdown menu, 41

Weekly Schedule, 42
Shutdown time

UPS group, 19
Shutdown timing, 29

DOS, 18
things to remember about, 30
to reconfigure, 29

Shutdown Timing Setup dialog box, 29
Shutdown/Reboot dialog box, 42
Shutdown/Reboot System, 42
SkyPage, 34
Software version, 44
Some radio button, 36
Stand-alone system support, 3
Standard, 28
Start, 39, 40, 41
Status

ABM, 26, 47
Battery, 47
battery, 26
communications, 26

Status messages, 2
String

to send to modem, 34
Substitution Variables box, 32, 34
Surge Condition, 52
Switch to DOS, 18

T

Test button (Broadcast Message to Users), 36
Test button (E-Mail), 34
Test button (Execute Command), 32
Test button (Send String to Modem), 34
Test Hardware, 39
Test Hardware dialog box, 39
Test hardware for network, 40
Test Hardware for Network dialog box, 40
Test hardware for the selected node, 39
Things to Remember About Shutdown Timing, 30
Time Needed to Down System, 29, 30, 52
Translate Battery Management Log to ASCII, 43
Translate Power Log to ASCII, 43
Troubleshooting, 45

U

Undervoltage, 26, 48
Uninterruptible power system (UPS)

Other-vendor, 12
UNIX, 3
Unload Power Monitor, 42
Unload the Power Monitor, 42
UPS, 52
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Load plugs, 37
UPS battery power, 26
UPS group, 52

communications requirements, 5
controller, 4, 19, 29, 39, 42
Group Unload dialog box, 42
member, 4, 19, 29, 39
node selection, 25
shutdown time, 19, 30
Shutdown Timing Setup dialog box, 29
support, 3
to configure network UPS access code for, 39
understanding, 4

UPS group controller, 30
UPS Group Unload dialog box, 42
UPSs

other manufacturers', 1

V

View menu, 25
View/Clear Battery Management Log, 43
View/Clear Power Event Log, 43
VIM, 33
Volts in, 26
Volts out, 27

W

Weekly Schedule, 42
Weekly scheduling, 1
Windows

to switch to DOS, 18
Windows 3.1x, 1, 3

system requirements, 7, 9
Windows 3.x Workstation

install path, 13

Index

Windows 95, 1, 3
system requirements, 7, 8

Windows 95, NetWare Network
install path, 13

Windows 95, NT NetworkWorkstation
install path, 13

Windows NT, 1, 3
system requirements, 7, 9

Windows NT cable, 12
Windows NT Workstation/Server

install path, 13
Windows Terminal program, 34
Wink Time, 29, 51, 52, 53
Workstation, 52, 53
Workstations, 25
Workstations check box, 39, 41
Workstations check list, 40
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